
NEWSLETTER #103 - June 2021

We have Recommended reading this month with the advent 
of Recommended Files for Excel, PowerPoint and Word.  But that’s not all: there is news on the demise of Internet Explorer, more 
functionality for Power Query on a Mac and details of increased file upload sizes for Microsoft 365 subscribers. 

Then there are all the regulars.  We have another Beat the Boredom Challenge, Charts & Dashboards, Visual 
Basics, Power Pivot Principles, Power Query Pointers, Power BI updates, Keyboard Shortcuts and one of the 
most useful Excel functions of them all that no one seems to know: FORMULATEXT.

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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Recommended Files
Microsoft Office now displays a list of recommended files on the File tab, or start page, of Word, Excel, or PowerPoint on Windows.  This list allows you 
to keep track of work around you and quickly access files with activity you value most such as edits, mentions, comments by people you interact with.

This feature uses machine learning to predict which files you're most likely to want to work on next and presents those as a set of cards you can 
choose from.  It should be noted though that only files that you have access to in OneDrive or SharePoint are suggested.  That’s probably why I don’t 
have any!

You do have a couple of things you can do to adjust how recommended files appears for you.

Remove a file from the list 

It should be noted that the following does not delete the file from your system, it simply removes it from the Recommended list.

For the file you want to remove: 

 • hover over the card for the file you want to remove
 • select the More options button (…)
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	 •	 select	‘Remove	from	list’.

Office	will	replace	the	card	with	a	card	for	the	next	best	Recommended	file.	

Collapse the Recommended section 

The Recommended section is shown expanded by default.  You can choose to minimise (or maximise once more) this section by clicking on the arrow 
to the left of the ‘Recommended for You’ section title.

The button is a toggle so if you click it the section will collapse and if you click it again it will re-expand.

Recommended files in Office has been available on Office.com and Office for Mac for a while and is now coming to Office on Windows, although it is 
currently available on Windows to Office Insiders on business or Enterprise subscriptions only.

Just before the publishing deadline hit for this newsletter, we are pleased to hear that there is new update to Power Query (PQ) in Excel for Mac – 
the ability to import data from local files.

Import Data from Local Files using Power Query in Excel for Mac
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Now you can import data from local files including Excel workbooks, text and CSV files.  This new functionality is available to Beta channel users 
running version 16.50 (build 21050400) or later.  

To import data from local Excel workbooks, text or CSV files (note: it’s not everything yet):

 • click Get Data (Power Query) on the Data tab
 • select Excel workbook or Text/CSV in the Choose data source dialog box
 • click Browse to select the local file
 • select the data you want to import and click the Load button.

Larger File Size Upload Limits

Death of Internet Explorer

This has been around a while now, but has had little fanfare, so trumpets at the ready…  

The Internet Explorer 11 (IE11) desktop application will be retired on Wednesday 15 June 2022. 

With the advent of “working from home” the new COVID-19 norm, 
remote work and learning has increased significantly.  This means there 
is now a greater need to reliably and securely share large files, such as 4K 
or 8K video files, 3D models, CAD files, photographs or even Excel files (!) 
with co-workers, clients and peers.  

Since the end of March allegedly (!), Microsoft has made it easier to 
store, synchronise and share large files in Microsoft 365.  The company 
has increased the upload file size limit for Microsoft 365 from 100 GB 
to 250 GB, which includes uploads of files into SharePoint, Teams and 
OneDrive. 

Microsoft has achieved the 250 GB limit by optimising storage for upload 
performance—each file is split into chunks and each piece is encrypted 
with a unique key.  All your files are backed up in Azure Storage, ensuring 
high availability and performance.  You can easily upload and download 
your large files when you need them, where you need them.

With something called differential sync, only the changes that you and 
your collaborators make are synchronised, shortening the amount of 
time it takes you to synchronise, helping improve performance and 
reducing network utilisation.  
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Microsoft has stated that the future of Internet Explorer on Windows 10 
is in Microsoft Edge,  and that Internet Explorer mode (IE mode) provides 
legacy browser support within Microsoft Edge.  This means that the IE11 
desktop application will no longer be supported and afterwards will 
redirect to Microsoft Edge if a user tries to access it.

If your organisation has legacy sites and applicationss with Internet 
Explorer dependencies, your business will need to set up IE mode so that 
users can access them through Microsoft Edge.

Imagine you have data as follows:

In this example, I have certain “amounts” for each item, and each item has been ‘auto-numbered’ using the formula

=SUBTOTAL(103,$G$13:$G13)

which is a great formula to use for autonumbering visible data.  For example, if I highlight all of the data, go to the ‘Data’ tab on the Ribbon and click 
on ‘Filter’ in the ‘Sort & Filter’ grouping (ALT + A + T), I can select ‘USA’ in the ‘Country’ filter as follows:

Beat the Boredom Challenge
With many of us currently “working from home” / quarantined, there are only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance in blood pressure millimetres of mercury (mmHg).  To try and keep our readers 
engaged, we will continue to reproduce some of our popular Final Friday Fix challenges from yesteryear in this and upcoming newsletters.  One 
suggested solution may be found later in this newsletter.  Here’s this month’s…
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and I will get

See how the auto-numbering accommodates the filtering?  Anyway, it’s a nice, useful trick but it distracts from this month’s conundrum…

Let’s imagine you want you to select ‘Australia’ from the ‘Country’ field:

Huh?  How come ‘USA’ is now part of the filtered ‘Australia’ subset?  I assure you I selected all of the data for filtering – so what went wrong and 
how can you correct it?

Sound easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  
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Charts and Dashboards
It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we look at the 
elements of a chart.

The range and quality of the charts Excel provides are excellent generally.  
However, there will almost always be items within the chart you wish 
to change.  Sometimes it may just be simple things like fonts, text sizes 
or colours, and other times it might be something more complex, like 
adding or formatting titles, legends or gridlines, or changing the axes 
scales or positions.  Thankfully, Excel makes performing these changes 
quite simple and many are applicable to almost every chart style.

Before looking at the various modification options, it is important to 
understand the structure of a chart.  Every chart will have a Chart Area, 
Plot Area, a Title and at least one data series, but other elements either 
vary from chart to chart or are optional.  Below is an illustration showing 
the typical chart elements:

Note the little circles on the corners and midway along each side of the 
Chart Area and Plot Area.  By holding my mouse on these markers, I can 
resize the chart and the plot area within the chart.

If I click and hold my mouse over the border of a chart element, I can 
move it.  Let’s say I want the Legend inside the chart, I would just single 
click on the legend and a circle marker appears on the outside of the 
Legend.  I can then ‘grab’ the legend by clicking and holding on the border 
of the Legend and move it inside the chart.  I can also resize the legend 
using the markers.  Note that not all chart elements can be moved, and 
if I accidentally move an element, I can perform an Undo (or CTRL + Z) to 
return it back to its previous position.

There are also three symbols on the right of the chart.  The plus sign 
button enables me to add, remove or change chart elements.  The paint 
brush button allows me to set a style or apply a colour scheme to my 
chart.  The funnel button gives me the ability to apply filters, thereby 

setting what data points and names are displayed.

To change the formatting for any of the chart elements, one of the 
easiest ways is simply to right click on a chart element.  A menu will then 
appear showing the various options I have to format the chosen chart 
element.

For example, if I want to change the background colour of the Plot Area, 
I would select the ‘Plot Area’ then right click and choose ‘Format Plot 
Area’, and a panel appears on the right side of the screen, allowing me 
to change the Fill and Border of the ‘Plot Area’, as well as many other 
options.

Let’s say I want the background of the chart to be shaded from green at 
the top to white at the bottom, I would change the Fill to ‘Gradient Fill’, 
specifying the colours I want and the direction of the shading.
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These panels of options are organised into groups, depending on the chart element I have chosen.  For the ‘Plot Area’, under the heading of ‘Plot 
Area Options’, there are two groups, namely ‘Fill & Line’ and Effects.

As I go through the chart elements, I also apply some modifications to the chart:

 • changing the fonts and font sizes of the titles and axes
 • changing the line and border colour of the Chart Area, the Plot Area and the Gridlines
 • adding colour to the background of the Plot Area
 • moving, resizing and putting shadow on the Legend
 • changing the colour of data series and applying lines around the data series columns
 • reducing the gap between the data series columns
 • modifying the units / scale for the axes.

I can achieve a customised chart to my preferences and needs.

For Axis, there are two headings, being ‘Axis Options’ and ‘Text Options’, and under each there are multiple option groups.

We’ll continue next month…
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Visual Basics
We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  This 
month, we look at scoping variables.

Last month’s article examined the value of declaring variables.  However, variables may also be used in different subroutines and functions.  If there 
are items that are known to have constant values throughout the entire workbook, they can be declared explicitly in one place for easy reference.

Let’s examine how variables can be scoped according to the needs of the project.  We’ll start with a simple function:

Why is it always, “Hello World!”?

This shows that the variable is IMPLICITLY declared.  However, to ensure that all variables are declared, at the beginning of the code the keywords 
“Option Explicit” are used:

When the routine is activated, the VBA compiler issues an error message saying it is not defined.  It must be defined by at least the Dim statement 
before it is run.

Let’s make a new subroutine referencing myTestString:

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

The declaration for the variable is in ScopeTest, but the subroutine calling it is not the one that defined it.

The “Variable not defined” message pops up again.  Let’s move the declaration OUTSIDE the subroutine, under the “Option Explicit” statement as 
follows:

When NextScopeTest is run the following happens:

However, if ScopeTest is run prior to NextScopeTest then we get:
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These graphics show that the variable is accessible to the entire module and is changed as required. The Dim statement outside any subroutines 
means the variable is accessible within the module that it is declared in.

You may notice that sometimes the ‘Private’ statement in declaration can be used. This is for module level sharing and identical to the Dim statement.  
Using the two is interchangeable and is more for more good coding practice. Using Private makes the code much more reasonable and draws to the 
eye immediately the scope of the variable.

Let’s move on.  What if another module wants to reuse the same variable?

Module2 wants to use myTestString, but it is declared in Module1.

Upon running, it again says “Variable not defined”.  In order to force a variable to be accessible to the entire workbook, the ‘Public’ statement may 
be used:
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the variable is used as necessary and the expected response happens.

Be careful though.  It’s not actually a good idea to maintain public 
variables between function calls.  It is much better coding practice 
for variables to be stored in subroutines and functions and passed as 
parameters.  There shouldn’t be any expectation for the VBA Project to 
maintain any values for variables.  This is because that there are lots of 
things that can cause a VBA project to reset whilst using the workbook.  
All public variables will get reset.

Another reason is that if multiple projects are open, other projects can 
call upon the variable as well which could lead to very interesting results.  

Save the heartache, avoid public variables.  It’s not just the stereotypical 
nightmare about appearing naked in public; variables get scared too!

There are more options for declarations that you might see including 
“Friend” and “Protected”. However, this is done at the Class level which 
are essentially the Objects of VBA. which is out of scope for this month!

More next time.

And now this will be accessible from Module2, so that when the following code is called,

Power Pivot Principles
We continue our series on the Excel COM add-in, Power Pivot.  This month, we consider the Calendar table.

When analysing data, it is important to be able to access past financial information so that comparisons can be made over a time period.  To allow us 
to perform comparisons more easily, we should utilise what is known as a Calendar table.  A Calendar table is a date table that links in with the dates 
in our data.  It is vital to have such a table in many types of relational database systems, including Power Pivot. 

Before we begin to create our Calendar table, there are two important points to remember:

 1. ensure that the start date in the Calendar table is before or on the earliest start date in your data model and end on or after the last date in  
  your data model
 2. dates must be contiguous (no gaps in days), in ascending order with no duplicates.

Let’s create our calendar table manually in Excel, first create the following headings:

 • Date 
 • Day 
 • Month  Year 
 • Day of Week 
 • Month Name (Long)

•	 Month	Name	(Short)	
•	 FY	
•	 Qtr	(CY)	
•	 Qtr	(FY)	
•	 Weekday	No.
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Highlight	the	table	headings	and	convert	the	range	into	a	Table	(CTRL + T):

Name	the	Table	‘Calendar’	in	the	‘Properties’	group	of	the	context-specific	‘Table	Tools,	Design’	tab	of	the	Ribbon.		We	can	now	enter	the	following	
formulae	under	each	heading:

	 •	 Date:	Ensure	the	start	date	is	before	or	on	the	earliest	date	contained	within	the	data	model
	 •	 Day:	=DAY([@Date])
	 •	 Month:	=MONTH([@Date])
	 •	 Year:	=YEAR([@Date])
	 •	 Day	of	Week:	=TEXT([@Date],"dddd")
	 •	 Month	Name	(Long):	=TEXT(MONTH([@Date]),"MMMM")
	 •	 Month	Name	(Short):	=TEXT(MONTH([@Date]),"MMM")
	 •	 FY:	=YEAR([@Date])+IF(MONTH([@Date])>=7,1,0)	(assumes June financial year-end)
	 •	 Qtr	(CY):	=ROUNDUP([@[Month]]/3,0)
	 •	 Qtr	(FY):	=MOD([@[Qtr (CY)]]-3,4)+1
	 •	 Weekday	No:	=WEEKDAY([@Date],2)

Our	Table	should	be	populated	as	follows	now:

The	next	step	is	to	add	this	table	to	Power	Pivot	and	ensure	the	table	is	still	called	‘Calendar’.

With	the	Calendar	table	highlighted	navigate	to	the	‘Design’	tab	and	select	‘Mark	as	Date	Table’.	

When	creating	new	PivotTables	from	our	Power	Pivot	data,	we	should	always	use	date	sources	from	the	Calendar	Table.		In	fact,	if	you	always	call	
your	date	field	in	the	Calendar	table	‘Date’,	then	any	time	series	function	in	DAX	requiring	a	date	should	cite	Calendar[Date]	–	simple!
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Create	a	PivotTable	with	fields	from	any	table	in	the	data	model,	then	use	the	date	fields	from	the	Calendar	Table.	

It	is	important	to	use	the	Calendar	Table	because	all	of	the	time	intelligence	functions	(for	example,	the	DATESYTD	function)	require	the	contiguous	
dates	to	function	properly.	

More	Power Pivot Principles	next	month.
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Power Query Pointers
Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from www.
sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at the 
‘Query Options’ screen and how it might be useful.

The ‘Query Options’ screen is on the ‘Data’ tab and may be found at the bottom of the dropdown when selecting ‘New Query’.

The screen gives you control over how your queries are created, either globally or in your current workbook, depending upon which tab you choose.  
Taking it from the top, ‘Use standard load settings’ sets the default action for where queries should be loaded:

 • for single queries, the default is to load to a new worksheet

 • for multiple queries, the default is to load to the data model. 

You may choose to specify the defaults instead, but in any case, we can 
override this when we are actually loading a query. 

‘Fast Data Load’ can also be set for individual queries in the ‘Query 
Properties’ screen (for more on this, please refer to Power Query: 
Managing Many Queries).  Microsoft describes the fast data load setting 
below, which means it depends how quickly you need the information 
from your query and whether you are happy to let Excel hang in the 
meantime!

The default behaviour is “Background Data Load”, but now users can 
instead choose the “Fast Data Load” mode in the Options dialog.  When 

loading a query using the “Fast Data Load” mode, your query will take 
less time to load, however, Excel may be unresponsive for long periods of 
time during the upload.

The ‘Data Cache Management Options’ basically show me the current 
size and limit of the cache and allows you to clear the cache and change 
the limit.  Caches generally speed up retrieval and this is no exception: 
copies of query preview results may be held here for faster access.  
Whilst the maximum size can be controlled, it’s not recommended to 
go below 32 MB.
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The ‘Query Options’ screen is mostly to do with how the Query Editor 
appears.  The ‘Parameters’ section is interesting and deserves more 
explanation.  If you enable ‘Always allow parameterization…’, then you 
may use the functionality associated with parameters from your query 

without first creating a parameter.  As more experienced users, we often 
switch this on, but someone who was going to stick to simple queries 
probably wouldn’t.  For more on parameters, please see Power Query: 
Passing Through Parameters.

The next tabs are to do with protecting data.  Requiring approval for new 
database queries is a sensible precaution, and warning users if they select 
a website that has not been approved as trusted or entered explicitly 
makes sense.  We keep these default settings.  I haven’t approved any 
ADFS authentication services, but if I did, they would appear here. 

Privacy levels are concerned with protecting my data sources and 
require a complete explanation – for this reason I will not try to simplify 

it.  Microsoft explain the levels and how to combine them here so that 
this article doesn’t have to!  You may choose to specify privacy settings 
globally and for my current workbook.

I am not going to show the Account tab, as that is part of my privacy 
settings (hard luck)…

Diagnostics can be used if serious problems are encountered in Excel.  I 
have created a simple query just to show what is created in the trace file.  
Any open Excel session will write to trace files until the session that has 

enabled tracing is closed or tracing is disabled.  The screen helpfully tells 
you where the trace files are kept by letting you access the folder.  One 
of my trace files is shown below:

mailto:contact@sumproduct.com
http://www.sumproduct.com
https://www.sumproduct.com/blog/article/power-query-blogs/power-query-passing-reference-to-excel-parameters
https://www.sumproduct.com/blog/article/power-query-blogs/power-query-passing-reference-to-excel-parameters
https://support.office.com/en-us/article/Privacy-levels-Power-Query-cc3ede4d-359e-4b28-bc72-9bee7900b540?CorrelationId=a4930b80-fee2-4c13-b370-1426e6c81363&ui=en-US&rs=en-US&ad=US&ocmsassetID=HA104009800


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

It’s coming to a theatre near you soon.

It is essentially a list of steps, but it’s used mainly to locate an error if there is a problem. 

Finally, you may set the locale for your current workbook on the ‘Regional Settings’ tab.  This influences how dates and times are interpreted as data 
is extracted.  This may be useful if you are dealing with data from other locations where dates are presented differently (for example, if you are based 
in the UK and deal with US data).  This only affects the query, not the underlying Excel workbook. 
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In the screenshot above, I have imported from my US file with my locale set to English (United States), and Power Query recognises that I have dates, 
as shown by the assumed data type.  I can now load my data.

As I have my location set as English (United Kingdom) in Excel, the date is now shown in the correct format for me.

In the image above, I have set my locale back to English (United Kingdom) and extracted my data again.  This time, the date fields appear as data type 
text because Power Query has not recognised this data as dates. 

When I load to my spreadsheet, the dates are not shown correctly.  Therefore, locale can be useful when I am using sources from other regions. 

More next month!
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Power BI Updates
This month’s updates include a new Preview of visual ToolTips, an ability to quickly create reports from SharePoint lists and an update on sensitivity 
labels so that they are now inherited “downstream”.  But there is more, of course!

The full list reads as follows:

Reporting

	 •	 Modern	visual	ToolTips	Preview
	 •	 Small	multiples:	now	on	by	default	and	updated	roadmap		 	
	 	 (Preview)
	 •	 New	Field	List	is	now	Generally	Available
	 •	 Support	for	removing	the	sensitivity	label	in	Power	BI	Desktop

Analytics

	 •	 Smart	Narratives	and	Anomaly	detection	are	now	Generally		
	 	 Available
	 •	 Q&A	now	supports	DirectQuery	for	Power	BI	datasets	and	Azure		
	 	 Analysis	Services

Modelling

	 •	 DirectQuery	for	Power	BI	datasets	and	Azure	Analysis	Services		
	 	 now	in	Preview
	 •	 Model	View	updates

Data Connectivity

	 •	 New	connector:	EQuIS
	 •	 Connector	update:	Automation	Anywhere
	 •	 Connector	update:	Vena
	 •	 Connector	update:	Azure	Databricks
	 •	 Connector	update:	Amazon	Redshift
	 •	 Connector	update:	Vertica
	 •	 Connector	deprecation:	Microsoft	Graph	Security

Service

	 •	 Quickly	create	reports	from	SharePoint	lists	(Preview)
	 •	 Reports,	apps	and	dataflows	endorsement	now	Generally	Available
	 •	 Datasets	hub	improvements

	 •	 Quick	Edit	Paginated	Reports	from	the	Service
	 •	 Single	sign-on	enabled	for	new	on-premises	data	sources	for		
	 	 paginated	reports
	 •	 Downstream	inheritance	for	sensitivity	labels	in	Preview

Mobile

	 •	 Work	side	by	side	with	other	apps	on	your	iPad	or	Android	tablet

Visualisations

	 •	 New	visuals
	 •	 ADWISE	roadmap	v2.0
	 •	 Bubble	chart	by	Akvelon
	 •	 Cycle	Plot	by	Nova	Silva
	 •	 Drill	Down	Donut	PRO	by	ZoomCharts
	 •	 Drill	Down	Map	PRO	by	ZoomCharts
	 •	 Drill	Down	Pie	PRO	by	ZoomCharts
	 •	 graphomate	charts	2021.2
	 •	 graphomate	matrix	2021.2

Template apps

	 •	 Dataflows	Snapshot	Analysis

Developers

	 •	 Dialog	boxes	support	for	Power	BI	custom	visuals
	 •	 Displaying	a	warning	icon	for	a	custom	visual

Other

	 •	 Share	and	Collaborate	in	Excel	for	the	web	connected	to	Power	BI.

Let’s	go	through	each	in	turn.

Modern visual ToolTips Preview

This update sees a public Preview of the new visual ToolTips!  These new ToolTips include datapoint drill actions and updated styling to match your 
report theme:
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You can turn on this new ToolTip in Power BI Desktop by going to File -> Options and settings -> Options -> Preview features -> Modern visual 
tooltips:

When you enable this Preview, all new reports will have the modern ToolTips enabled by default.  However, to enable these new ToolTips for existing 
reports, you’ll need to navigate to the ‘Report settings’ and turn on the ‘Modern visual tooltips’:
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Once you enable these new ToolTips, you’ll be able to drill down / up and drill through on a datapoint, without having to use the right-click menu or 
visual header.  In this example, you can see the user is hovering over the Word datapoint, and they have the option to ‘Drill down’ on the datapoint 
or ‘Drill through’:

If the user clicks ‘Drill down’, the visual will update to display the next level in the hierarchy and filter to Word.

If the user selects ‘Drill through’, they will be able to see which pages they can drill through to:
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Selecting ‘Market Basket Analysis’ from the ToolTip will drill through to the ‘Market Basket Analysis’ page and filter the page to Word or any other 
filters on the source datapoint.

Once you upgrade to the new ToolTips, you’ll also see that the colours for the ToolTips are now based upon the report’s theme colours:

 • the background of the ToolTips default to the ‘Background elements’
 • the text and icon colour of the ToolTips default to the ‘First-level elements’
 • the separator line and hover colour on the ToolTip default to the ‘Secondary background elements’.

Here’s an example of the styling for the Default theme:

Here’s an example with for the Innovate theme:
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Here’s an example with the Frontier theme:

If you want to customise the styling further, you can always update the ToolTip theme in the ‘Customize theme’ dialog:

Additionally, if you want to format ToolTips per visual, you can customise the settings in the Format pane:
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As great as they may be, currently, drill actions are not available in the ToolTip for the following scenarios / features:

 • Report page ToolTips
 • AppSource visuals (Custom visuals)
 • Matrix visuals
 • Line charts
 • Area charts
 • Stacked area charts
 • Decomposition trees.

Presently, it’s not possible to have visual-level control to turn on / off the drill actions for the ToolTips.  To do this, you will need to enable / disable 
this capability at a report-level.

Small multiples: now on by default and updated roadmap (Preview)

New Field List is now Generally Available

Support for removing the sensitivity label in Power BI Desktop

Smart Narratives and Anomaly detection are now Generally Available

The small multiples Preview feature is now enabled by default.  This 
means it’s “not quote Generally Available”!  Microsoft has stated that 
they want to give it that “extra bit of discoverability as [they] continue 
our work on it, giving everyone a chance to find and try it out”.  

Additionally, this month, you can now set date hierarchies in your small 
multiple visuals to render as continuous axes.  This is useful when using 
date hierarchies in line charts, for example, which will now allow you to 
see each line smoothly, without needing to scroll the axis horizontally.

The new Field List is now Generally Available for Power BI Desktop and 
will shortly be coming for Power BI Service too.  This change will create 

consistency for functionality and user interface across views (where 
applicable) to address pre-existing customer feedback and confusion.

While removing sensitivity labels isn’t something Microsoft recommends, 
this update has added this capability for customers who need to remove 
the label from the PBIX file.  To remove a label from a file in Power BI 

Desktop, select the Sensitivity (Preview) button on the toolbar, and then 
click on the currently applied label (marked with a checkmark).  This will 
deselect the label and remove it from the file.

Both Smart Narratives and Anomaly Detection are now Generally 
Available.  Further, Smart Narratives now supports summarisation of 
more visuals such as Maps, KPI, Gauge, Card, Multi Card, Key Influencers 

and localisation for no less than 43 languages.  Anomaly Detection and 
Smart Narratives are now fully accessible. 
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Q&A now supports DirectQuery for Power BI datasets and Azure Analysis Services

Q&A now supports DirectQuery for Power BI datasets and Azure Analysis Services.  Furthermore, as part of this update, it is now possible to use Q&A 
setup against Azure Analysis Services models.  This should unlock multiple scenarios including the ability to:

 • define custom synonyms
 • train Q&A custom business terms
 • set featured questions
 • see what questions were asked 
 • see flagged questions from end users.

As a reminder, DirectQuery for Power BI datasets and Azure Analysis Services is in Preview, so you’ll need to make sure the preview is enabled:
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DirectQuery for Power BI datasets and Azure Analysis Services now in Preview

LINEAGE VIEW AND IMPACT ANALYSIS SUPPORT

DISCOURAGE CHAINING

Q&A SUPPORT

Microsoft has added support for this feature to the lineage view and impact analysis, both in the Service and in Power BI Desktop.  Regardless of 
if the dataset is in the same workspace as the source datasets or in a different workspace, you can see it in lineage view and impact analysis.  This 
allows you to:

 • gain confidence in your data by understanding its sources
 • troubleshoot your data flow to understand data mismatches and not up-to-date data
 • see what can be impacted by a change in dataset and notify contacts about an upcoming change.

When you publish a dataset from Power BI Desktop, you can now see, in addition to reports and dashboards, what other datasets are directly 
connected to this dataset that you publish.  You can then open the Power BI Service to see more details and notify relevant contacts about the change.

Microsoft has noted that users want the ability to limit which Power 
BI datasets and Azure Analysis Services datasets may be connected to 
through DirectQuery.  Previously, the only way to limit this was through 

using third-party tools.  Now, this update has added in a switch into the 
Options dialog in Power BI Desktop, so you may easily limit “DirectQuery-
ing” (new word, look it up) to datasets.

Q&A now supports DirectQuery for Power BI datasets and Azure Analysis Services.
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Model View updates

New connector: EQuIS

Connector update: Automation Anywhere

Connector update: Vena

Connector update: Amazon Redshift

Quickly create reports from SharePoint lists (Preview)

Connector update: Vertica

Connector deprecation: Microsoft Graph Security

Connector update: Azure Databricks

There are a few updates to upgrade to the new Model View experience 
this month.  There aren’t any changes to the Model View user interface 
this month, but you should be aware that the new Model View will soon 
be the default experience.

First, you may see a dialog that asks you to upgrade to the new model 
view user interface.  You should ensure that you have enough time to 

upgrade your existing PBIX’s before this change is made automatically.  
But do remember, if you upgrade, it will be permanent.

Second, when you create a new PBIX, the Model View will have the new 
user interface as its default. 

There is now an EQuIS connector in Power BI Desktop.  This enables to 
directly and easily access EQuIS data in Microsoft Power BI via the EQuIS 
Enterprise REST API.  The EQuIS connector supports three types of user 
authentication: basic, API token and organisational account (aka Azure 

Active Directory).  Through a secure, encrypted connection to the EQuIS 
REST API, the EQuIS connector allows users to import a variety of EQuIS 
datasets into Power BI (including facility data, location data and tabular 
report data). 

The Automation Anywhere connector has been updated.  It should also be noted that the A2019 cloud version has been updated and renamed to 
Automation 360 within the connector.

The Vena connector has also been updated.  This updated version includes support for rollup operators from Vena.

The Amazon Redshift connector has been updated to enable AAD Authentication in Power BI Desktop.  You should note though that this type of 
authentication is not available in the Service.

The Vertica connector has been updated with a bug fix to support supplying a port value when connecting to Vertica.

The Microsoft Graph Security connector is being deprecated, due to 
support ending from the data source service.  This update will remove 
the connector from the ‘Get Data’ experience in Power BI Desktop, 

discouraging new connections from being made.  Existing connections 
and reports will continue to work for now.  Sounds ominous!

The Azure Databricks connector has been updated.  Apparently, it now has:

 • better support for Unicode characters in DirectQuery mode
 • a harder to access ‘Batch Size’ option, as this has now been deprecated and removed from the Connector dialog, but this functionality may  
            still be provided in the Advanced (Query) Editor.  Existing saved connections will not be affected
 • minor improvements in query generation.
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This update sees the launch of Power BI integrated within SharePoint lists.  This experience empowers SharePoint list and Microsoft List users 
to easily explore their list data with just a few clicks.  If you’re part of the Targeted release experience, this capability is rolling out now, with the 
Standard release “…set in the future…”.  It sounds like a new sci-fi drama.

Reports, apps and dataflows endorsement now Generally Available

Datasets hub improvements

Quick Edit Paginated Reports from the Service

Last year saw the public Preview of reports and applications (apps), and 
dataflows endorsement.  This capability is now Generally Available.

This now provides organisations with a mechanism they may use to 
distinguish their most valued and trusted content.  Content certification 
may be tightly controlled and documented via an administrator control, 
ensuring that certification is a selective process.

Any content owner can promote their content, thereby marking it as 
trusted and ready to be shared.  This promoted content will get better 
visibility in a variety of Power BI experiences, making it easier for business 
users to discover.

When you click on a specific dataset in the Datasets hub or in the ‘Workspace content’ list, you get to the ‘Dataset details’ page.  In the ‘Dataset 
details’ page, you’ll see some metadata about the dataset, actions you can perform and reports built on top of these datasets that you have access to.

With this release, there will be more metadata and actions you can perform from the ‘Dataset details’ page:

 • Tables view.  An essential piece of dataset metadata is the dataset’s tables and its columns and measures.  With this improvement, you no  
  longer need to open a dataset in Power BI Desktop as it is all available as part of the dataset details page
 • Action bar.  This update addas an action bar to the top of the page to make all the actions available from within the dataset details page.

Apparently, there will be more actions, such as dataset refresh and view refresh history, coming soon.

An ‘Edit in Power BI Report Builder’ option has now been 
added, to allow easier editing of Paginated Reports from 
the Service.  Selecting this option will open the Paginated 
Report directly in Power BI Report Builder, where edits 
may be made.  When you have finished making changes to 
the report, you can publish it back to the Service by simply 
selecting Publish.

You can find the new ‘Edit in Power BI Report Builder’ 
option by clicking the ellipsis menu (…) next to a Paginated 
Report in a workspace.
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This option is also available in the File menu when you have a Paginated Report open in the Service.

Single sign-on enabled for new on-premises data sources for paginated reports

This month sees the announcement of single sign-on (SSO) support for 
the gateway for your paginated reports, backed by either a SQL Server or 
Oracle on-premises data source.  SSO makes it easy for paginated reports 
to refresh data from on-premises sources, while respecting user-level 
permission configured on those sources.

Once you have configured SSO through the gateway for either your 
SQL Server or Oracle data source, it’s straightforward to enable SSO for 
a paginated report using that data source.  In the ‘Gateway connection’ 
settings for your paginated report, select your data source to ‘Add to 
gateway’.  From the ‘Advanced settings’, you then choose to use SSO for 
your paginated report.
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Downstream inheritance for sensitivity labels in Preview

New visuals

ADWISE roadmap v2.0

Work side by side with other apps on your iPad or Android tablet

Microsoft has stated they have “…introduce[d] the first-in-the-market label 
inheritance feature to provide more effective and accurate content 
labelling”.  With downstream inheritance of sensitivity labels, when you 
apply a sensitivity label to a dataset or report in the Power BI Service, it 
propagates down to any other content that uses that dataset or report as 
its underlying data.  With downstream inheritance, you don’t need to rely 

on multiple users to properly label and maintain the sensitivity of the data 
in use.  Instead, you can trust the content creator (e.g. the dataset owner 
or the report author), as the one who is most familiar with the data, to tag 
the content most accurately with the proper sensitivity label as soon as it 
is published to the cloud.

There is the usual slew of new visuals:

 • Advanced Toggle Switch
 • Craydec Timelines
 • Go To Stratum
 • graphomate bubbles
 • graphomate pictograms
 • PureViz Infographic
 • Soza Health Dial
 • Tachometer by E&A.

The latest version of this visual has been added.  This visual allows you to plan, roadmap and schedule phases and milestones.  This visual can help you 
present your project, product, campaign plans, or visualise whatever else that may be “time-scheduled” (don’t ask me, it must be a US word).

The new version 2.0 includes:

 • zoom functionality: now you can zoom your RoadMap to see more details or fit larger datasets, horizontally as well as vertically
 • scrolling: once your RoadMap does not fit into visual area (page), scroll bars will appear
 • fixed height of rows (option): rows remain the same height when you are filtering, adding more data etc. (more suitable for scrolling large data  
  sets)
 • progress bars: you can show progress (of project) within the bar
 • bars: different types of edges / corners (square or rounded) are now available, to better suit your graphical preferences
 • left axis: right / left label alignment and text wrapping are now available
 • standard Power BI font added: Segoe UI was added.

You can find this updated visual in AppSource.

Being able to multitask with two apps open side by side on your mobile 
device is very useful.  You may now do this with the Power BI Mobile app 
on supported iPad and Android tablet devices.  Whilst viewing the relevant 
data in the Power BI mobile app, you can write an email, take notes about 

important analysis insights or even discuss the data with colleagues via 
chat.  Indeed, you do not even have to switch between screens and lose 
the context. 
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Bubble chart by Akvelon

This Bubble Chart is one of the most popular custom visuals by Akvelon – which now has new features in version 2.2.2:

 • second level of bubble labels: this is quite useful to show not only the name of the bubble, but also secondary information, for example sales  
  per category.  Users may drop columns from their data source into the ‘Secondary label’ field bucket to use second level bubble labels
 • word wrapping inside of bubble labels, on both levels: now, Power BI users can show more text information on bubbles by wrapping text  
  where needed.  Users can find this switch in the Formatting settings of the visual
 • visual updated to meet new certification requirements by Microsoft: this now prevents loading external resources into a visual.  Now, users  
  can take a column from their data source that contains a binary image and show it on a bubble surface. 

The latest version of Bubble Chart by Akvelon is available in the AppSource.

Cycle Plot by Nova Silva

Time series visualisations are frequently used to clarify and quantify 
changes over time in measures.  However, the trusty line chart can hide 
important patterns.  This happens when the measure contains seasonality.  

The Cycle Plot is a special line chart developed to show seasonal time 
series.  It helps you to visualise trends within seasonal data. 
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For example, imagine you are reviewing items sold over several weeks.  
You might expect to sell more on weekdays compared to the weekend.  
A line chart will show low values during the weekend and higher values 
during the week.  However, it’s hard to tell if sales on Mondays are 
increasing or decreasing over the weeks.  With the Cycle Plot, a subplot 
can be created for each day.  You can show the change in sales over time 

for that day.  All the subplots together still show the seasonal pattern as 
well, as seen in the image above.
Again, you can download this from the AppSource.  All features are 
available for free to evaluate within Power BI Desktop.

Drill Down Donut PRO by ZoomCharts is a donut chart with touch-driven interactions that allows data exploration.  You may click directly on the slice to 
drill down into the data category, pick a chart type and use various customisation options to control the look of the chart.  

The new version 1.7 adds the following:

 • built-in quick access links: when you place the visual on the report canvas, you are presented with quick links to useful sections of ZoomCharts  
  website related to the visual
 • improved licence and trial experience: you may try paid features of ZoomCharts Drill Down Donut Pro for 30 days for free.  After the free  
  period, you can extend the free access by 30 more days with a free ZoomCharts trial
 • improved responsiveness: resize your chart to various dimensions.

To evaluate the Drill Down Donut PRO, simply download the visual from, yes, you’ve guessed it, the AppSource.

Drill Down Donut PRO by ZoomCharts

Drill Down Map PRO by ZoomCharts
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Drill Down Map PRO by ZoomCharts lets you visualise location data on maps.  This Power BI map pie chart (above) allows you to explore data by country, 
city or use the lasso tool to create storable filters for custom regions.  Add pie charts on top of the map to visualise clusters of data.

The new version 1.7 adds the following:

 • built-in quick access links: when you place the visual on the report canvas, you are presented with quick links to useful sections of ZoomCharts  
  website related to the visual
 • improved licence and trial experience: you may try paid features of ZoomCharts Drill Down Donut Pro for 30 days for free.  After the free  
  period, you can extend the free access by 30 more days with a free ZoomCharts trial
 • improved responsiveness: resize your chart to various dimensions
 • numerous functionality and performance improvements.

To evaluate the Drill Down Map PRO, it’s again available from the AppSource.

Drill Down Pie PRO by ZoomCharts

graphomate charts 2021.2

graphomate charts apply the basic principle 
‘Information, not decoration!’ and concentrate on 
getting the information across to the end user.

Therefore, the intention is to deliberately condense 
the display of key performance indicators (KPIs), 
meaning that you’re able to show more data on the 
same page.  Therefore, your data is better embedded 
into the context. 

You may choose between six chart layouts, which can 
be aligned horizontally to represent data over a time 
period or vertically to show elements in a structured 
manner.  All graphomate charts on a report page can 
be scaled within the same range to avoid misleading 
interpretation.

This is again available in the AppSource.

There is a new version of Drill Down Pie Pro by ZoomCharts as well.  Again, this supports touch-driven interactions, adjustable slices, and various other 
customisation options.
The new version 1.7 adds the following (at the risk of sounding like a broken record):
 • built-in quick access links: when you place the visual on the report canvas, you are presented with quick links to useful sections of ZoomCharts  
  website related to the visual
 • improved licence and trial experience: you may try paid features of ZoomCharts Drill Down Donut Pro for 30 days for free.  After the free  
  period, you can extend the free access by 30 more days with a free ZoomCharts trial
 • improved responsiveness: resize your chart to various dimensions.

To evaluate the Drill Down Pie PRO, it’s also in the AppSource.
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Dataflow Snapshots Analysis 
Dataflow Snapshots Analysis  

– Power Apps

Summary view
In	the	Summary	page,	you	can	view	
the	main	data	changes,	review	missing	
or	new	records,	and	find	trends	of	key	
profiling	metrics.			

Differences view
In	the	Differences	view,	you	can	review	
all	data	changes	in	more	detail	in	a	
tabular	format	and	slice	/	dice	the	
changes	by	tables,	change	types,	or	
time	periods.		For	example,	you	can	
filter	the	missing	records	or	changes	to	
a	specific	table	by	period.	

Profiles view
The	Profiles	view	highlights	selected	
profiling	metrics	by	tables,	columns	
and	snapshot	dates,	and	allows	you	to	
find	anomalies	in	any	column	in	your	
tables	based	on	minimum,		
average,	maximum,	standard		
deviation,	null	count,	distinct	count	
and	row	count.
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graphomate matrix 2021.2

Dataflows Snapshot Analysis

Often data is structured in a hierarchical way.  The graphomate matrix allows the visualisation of hierarchies in rows and columns.  A good layout design 
allows you to understand the data quickly and easily. 

The matrix visual provides various formatting options:

 • multiple highly customisable value formatting options for distinct columns
 • conditional styling of cells and values
 • calculation of relative and absolute deviations
 • display of correctly scaled In-Cell Charts as bar or pin
 • custom features may be written, using the built-in cell formatting language
 • the graphomate matrix allows both a hierarchical and a tabular (Cross Tab) view.

Yet again, it’s available from the AppSource.

Maintaining high data quality is a challenge in any BI or data-driven 
business application.  Developers spend significant time creating complex 
data preparation processes with highly maintained pro-code tools or 
avoid automation and focus on executing long manual testing.  As a result, 
data quality issues require more time and resources to detect and fix.  
DataChant has recognised this and released two new Power BI apps that 
leverage Power Query low-code data-shaping capabilities to deliver a data 
quality monitoring solution that monitors snapshots of your data as it gets 

refreshed in Power BI and Power Apps dataflows.

The Power BI Dataflow Snapshots Analysis and Dataflow Snapshots 
Analysis – Power Apps allow you to monitor your ADLS Gen2-connected 
dataflows and analyse their auto-generated snapshots.  The apps read 
the snapshots and their CDM meta-data, profile the tables and look for 
changes in records over time. 

Each app includes three report pages:
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Dialog boxes support for Power BI custom visuals

Displaying a warning icon for a custom visual

Presently, dialog boxes may only open within the borders of a custom 
visual.  This new API will enable developers to set the dialog box to open 
outside the custom visual’s borders.

For instance, a dialog box can be used to display additional information 
to the user, or to display a calendar for a date picker.  In such cases, the 

report author doesn’t have to enlarge the visual boarder anymore, in 
order to see the full details the visual is generating.

The developer can display this data as a modal dialog box that will be 
triggered by a user action.  The API is available with the 3.8 API release.

This API standardises the warning icon in the custom visual frame, in a way that is similar to the out-of-the-box visuals in Power BI.  The API is available 
with the 3.7 API release. 

The warning icon is triggered by the visual and will show in reports when users hover over the visual.

Out-of-the-box visuals display the warning icon when there are queries, issues or invalid data.  For instance:

 • maps give warnings for values outside latitude / longitude valid values
 • Pie charts warn about negatives mixed with positives
 • Cartesian charts warn about infinity values being dropped.
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Share and Collaborate in Excel for the web connected to Power BI

DOWNLOAD A CONNECTED WORKBOOK IN THE POWER BI SERVICE

CONNECT TO POWER BI DATASET IN EXCEL DESKTOP

Microsoft has recently announced the initial availability of a connected PivotTable refresh in Excel for the web.  This new capability makes it easier 
for organisations to share data and collaborate using Power BI and Excel.  You can now explore, and refresh PivotTables connected to Power BI inside 
Excel for the web, and easily share these workbooks through OneDrive and SharePoint.

Combined with Microsoft Information Protection (MIP) sensitivity labels now fully integrated, you can control sharing to keep your data trusted and 
secure.

To create a PivotTable connected to Power BI, you must create a workbook using one of these following entry points:

 • Download a connected workbook in the Power BI Service
 • Connect to a Power BI dataset in Excel Desktop.

In the Power BI service, open any report or dataset you have access to and use the ‘Analyze in Excel’ option to download an Excel workbook 
connected to the underlying dataset. 

In the Excel Desktop Ribbon, connect to a Power BI dataset using either Insert -> PivotTable -> From Power BI or Data -> Get Data -> From Power BI.

You then save the workbook in OneDrive, OneDrive for Business or SharePoint Online.

You then save the workbook in OneDrive, OneDrive for Business or SharePoint Online.
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To refresh the connected PivotTable in Excel for the web, you then have one of two options:

 1. directly in the browser
 2. share Excel workbooks in Power BI Apps.

DIRECTLY IN THE BROWSER

SHARE EXCEL WORKBOOKS IN POWER BI APPS

The connected PivotTable can be refreshed by directly pasting the link to the workbook in your web browser.  The link can be copied either by using 
the ‘Share’ button in the workbook or File -> Info -> Copy path.  Users may now interact with the connected PivotTable in Excel for the web by 
dragging fields into the PivotTable area with the data staying connected to Power BI.

To ensure changes made to the workbook in Excel for the web, close any version of the workbook open in Excel Desktop.

Another way to deliver Excel data analysis and visualisation across your organisation is by including Excel workbooks in Power BI Apps.  Now that data 
refresh is fully supported, the workbooks in Power BI apps will stay up to date. 

However, it should be noted that Power BI datasets built upon live connections to Analysis Services are not currently refreshable in Excel for the web.

More next month, we’re sure!
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The A to Z of Excel Functions: FORMULATEXT

The A to Z of Excel Functions: FREQUENCY

First released in Excel 2013, this is one of the most used functions in our neck of the woods.  It’s a really useful tool for documenting formulae, as 
FORMULATEXT returns a formula as a text string.  People have been writing User-Defined Functions (UDFs) for years to replicate that! 

Useful for constructing histograms, FREQUENCY calculates how often 
values occur within a range of values (known as “bins”), and then returns 
a vertical array of numbers.  For example, you may use FREQUENCY to 

count the number of test scores that fall within ranges of scores.  Because 
FREQUENCY returns an array, it must be entered as an array formula (i.e. 
by entering it using the keystrokes CTRL + SHIFT + ENTER).

The FORMULATEXT function employs the following syntax to operate:

FORMULATEXT(reference)

The FORMULATEXT function has the following argument:

 • reference: this is required and represents a cell or a reference to a range of cells.

It should be further noted that: 

 • the FORMULATEXT function returns what is displayed in the formula bar if you select the referenced cell
 • the reference argument can be to another worksheet or workbook
 • if the reference argument is to another workbook that is not open, FORMULATEXT returns the #N/A error value
 • if the reference argument is to an entire row or column, or to a range or defined name containing more than one cell, FORMULATEXT returns  
  the value in the upper leftmost cell of the row, column, or range
 • in the following cases, FORMULATEXT returns the #N/A error value:
   o the cell used as the reference argument does not contain a formula
   o the formula in the cell is longer than 8,192 characters
   o the formula cannot be displayed in the worksheet; for example, due to worksheet protection
   o an external workbook that contains the formula is not open in Excel.
 • invalid data types used as inputs will produce a #VALUE! error value
 • entering a reference to the cell in which you are entering the function as the argument will not result in a circular reference warning 
  FORMULATEXT will successfully return the formula as text in the cell.

Please see our example below:
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The FREQUENCY function employs the following syntax to operate:

FREQUENCY(data_array, bins_array).

The FREQUENCY function has the following arguments:

 • data_array: this is required and represents an array of, or a reference to, a set of values for which you want to count frequencies.   
  If data_array contains no values, FREQUENCY returns an array of zeros (0’s)
 • bins_array: this is also required.  This denotes an array of, or reference to, intervals into which you want to group the values in data_array.   
  If bins_array contains no values, FREQUENCY returns the number of elements in the data_array.

It should be further noted that: 

 • FREQUENCY is entered as an array formula in some versions of Excel (CTRL + SHIFT + ENTER) after you select a range of adjacent cells into  
  which you want the returned distribution to appear
 • the number of elements in the returned array is one more than the number of elements in bins_array.  The extra element in the returned  
  array returns the count of any values above the highest interval.  For example, when counting three ranges of values (intervals) that are  
  entered into three cells, be sure to enter FREQUENCY into four cells for the results.  The extra cell returns the number of values in data_array  
  that are greater than the third interval value
 • FREQUENCY ignores blank cells and text
 • formulae that return arrays must be entered as array formulae (CTRL + SHIFT + ENTER).

Please see my example below:

More Excel Functions next month.
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Beat the Boredom Suggested Solution
This month's challenge was about filters not working in a simple data table in Excel.  In our previously cited example, this file had data in the following 
format:

Highlighting the entire selection, I went to the ‘Data’ tab on the Ribbon and clicked on ‘Filter’ in the ‘Sort & Filter’ grouping (ALT + A + T) to create a 
filtered list.  I then filtered on ‘Country’ for Australia and obtained the following subset:

The problem was that when I did this ‘USA’ became part of the filtered ‘Australia’ subset.  The questions were, why did this happen and how do you fix it?  

The problem here resides with the formula in cells F13:F42, namely

=SUBTOTAL(103,$G$13:$G13)

Yes, I said earlier it was a great formula, as it will auto-number visible data, but there is an inherent problem in this formula too.  Let me explain by 
first recapping on the SUBTOTAL function.  On the face of it, it seems like many other Excel functions:

=SUBTOTAL(function_number, ref1, ref2, …)

The function_number is an integer between 1 and 11 inclusive or 101 and 111 inclusive as follows:

mailto:contact@sumproduct.com
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For the function_number constants from 1 to 11, the SUBTOTAL function 
includes the values of rows hidden by the ‘Hide Rows’ command under 
the ‘Hide & Unhide’ submenu of the ‘Format’ command in the ‘Cells’ 
group on the ‘Home’ tab.  These constants should be used when you 
want to subtotal hidden and unhidden (visible) numbers in a list.  For the 
function_number constants from 101 to 111, the SUBTOTAL function 
ignores values of rows hidden by the ‘Hide Rows’ command.  These 
constants should be used when you want to subtotal the visible numbers 
in a list only.

If there are other subtotals within ref1, ref2, … (or nested subtotals), 
these nested subtotals are ignored.  This is an important feature as it 
allows you to consider complete ranges without any risk of double-
counting.

SUBTOTAL(103, range) acts like COUNTA excluding any hidden cells, i.e. 

it counts the number of non-empty visible cells in range.  That’s how the 
auto-numbering works.

There’s just one problem.

SUBTOTAL also works with the built-in subtotal functionality of Excel, which 
totals numbers excluding – essentially, ignoring – the SUBTOTAL function.  
Therefore, Excel is trained to ignore what it thinks are subtotal rows.  

Look again at the USA row included.  It’s the final row of the data 
selection and it begins with a SUBTOTAL function.  Excel thinks it’s a 
subtotal calculation.  Therefore, it has excluded it quite deliberately 
from the filtering believing it to be a subtotal of the data.  Since the 
function_number lies between 101 and 111, Excel realises this function 
is designed to include filtered items only, so programmatically it makes 
sense to retain this row.  Excel thinks it’s the sum of the above!

There are several ways that this logic can be defeated:

 1.  double unary: (careful, that’s not “urinary”) possibly first discovered by Excel guru Dick Kusleika, putting two minus signs straight after the  
   equals sign (e.g. =--SUBTOTAL(103,$G$13:$G13) ) fools Excel into thinking it’s a different formula.  The first minus sign negates the calculation;  
   the second makes it positive again

 2.  multiplying by 1: this one I am taking credit for!  Who in their right mind would multiply a total by 1?  Excel therefore thinks it isn’t a total and  
   hence it becomes part of the filter set

 3.  add a column before the Item Number: In most instances (but sadly, not all), adding a column of data before the column containing SUBTOTAL  
   will make the dataset work as intended.  Suddenly Excel doesn’t believe the bottom row is a total anymore

 4.  add a blank row at the bottom: put a (sub)total at the bottom of the data?  That’s just what Excel expected you to do!  So don’t.  Make it  
   the penultimate row of the data by making a blank row part of the dataset.  This is often quoted on the internet, but I think this is a terrible  
   solution. If you need to add data, you’ll need to insert it before the blank row.  What end user would appreciate the first blank row is part of  
   the dataset?  Further, blanks will be included in the list of options for the ‘Country’ filter.  This is not an ideal fix

 5.  convert the data range to a Table: by highlighting the data and then converting the range to a Table (CTRL + T), filtering will work as expected  
   – and you will get built in filtering as a bonus!  Table totals work in a different way, so Excel is not confused by the SUBTOTAL formula.  I quite  
   like this solution as it requires no modification to the formula or need to add a row or column.

Other than adding a blank row (not sold on that at all), the others all have their strengths and weaknesses.  I don’t want to advocate one solution over 
another.  Hopefully, you came up with one of the above.  If not – and it works – do let us know…

You can find out more about SUBTOTAL and Excel’s subtotal functionality here.  For more tricks and tips, check out our many examples at  
www.sumproduct.com/thought.

Until next time.

 

Upcoming SumProduct Training Courses - COVID-19 update
Due	to	the	COVID-19	pandemic	that	is	currently	spreading	around	
the	globe,	we	are	suspending	our	in-person	courses	until	further	
notice.		However,	to	accommodate	the	new	working-from-home	
dynamic,	we	 are	 switching	 our	 public	 and	 in-house	 courses	 to	
an	online	delivery	stream,	presented	via	Microsoft	Teams,	with	
a	 live	 presenter	 running	 through	 the	 same	 course	 material,	
downloadable	 workbooks	 to	 complete	 the	 hands-on	 exercises	
during	 the	 training	session,	and	a	 recording	of	 the	sessions	 for	

your	 use	within	 1	month	 for	 you	 to	 refer	 back	 to	 in	 the	 event	
of	 technical	 difficulties.	 	 To	 assist	 with	 the	 pacing	 and	 flow	 of	
the	course,	we	will	also	have	a	moderator	who	will	help	answer	
questions	during	the	course.

If	 you're	 still	 not	 sure	 how	 this	will	work,	 please	 contact	 us	 at	
training@sumproduct.com	 and	 we'll	 be	 happy	 to	 walk	 you	
through	the	process.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If	you	have	any	tips,	comments	or	queries	
for	future	newsletters,	we’d	be	delighted	
to	hear	from	you.	Please	drop	us	a	line	at	

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
·  Business planning
·  Building three-way integrated   
	 financial	statement	projections
·  Independent expert reviews
·  Key driver analysis
·		 Model	reviews	/	audits	for	internal		 	
	 and	external	purposes
·		 M&A	work
·		 Model	scoping
·		 Power	BI,	Power	Query	&	Power	Pivot
·		 Project	finance
·		 Real	options	analysis
·		 Refinancing	/	restructuring
·		 Strategic	modelling
·		 Valuations
·		 Working	capital	management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Hey, it’s not our fault so many do the same thing this month!

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This year, we thought we’d revisit each 
function key in depth (there are 12 – one for each month of the year!).  Given it’s now June, let’s look at the F6 tips, some of which are a Pane:

Keystroke What it does

F6 Next	Pane

ALT	+	F6 Switch	to	VBA	Integrated	Development	Environment	(IDE)	(assuming	it	is	open	already)

CTRL	+	F6 Next	window	/	workbook

SHIFT	+	F6 Previous	Pane

CTRL	+	ALT	+	F6 Previous	window	/	workbook
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Location Course Date Date Duration Duration

Online	(Australia) Power	Pivot,	Power	Query	and	Power	BI 15	-	17	Jun	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 3	Days

Online	(Australia) Excel	Tips	and	Tricks 22	Jun	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 1	Day

Online	(Australia) Financial	Modelling 23	-	24	Jun	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 2	Days

Online	(Australia) Power	Pivot,	Power	Query	and	Power	BI 19	-	21	Jul	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 3	Days

Online	(Australia) Excel	Tips	and	Tricks 26	Jul	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 1	Day

Online	(Australia) Financial	Modelling 27	-	28	Jul	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 2	Days

Online	(Australia) Power	Pivot,	Power	Query	and	Power	BI 23	-	25	Aug	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 3	Days

Online	(Australia) Excel	Tips	and	Tricks 30	Aug	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 1	Day

Online	(Australia) Financial	Modelling 31	Aug	-	1	Sep	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 2	Days

Online	(Australia) Power	Pivot,	Power	Query	and	Power	BI 29	Sep	-	1	Oct	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 3	Days

Online	(Australia) Excel	Tips	and	Tricks 6	Oct	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 1	Day

Online	(Australia) Financial	Modelling 7	-	8	Oct	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 2	Days

Online	(Australia) Power	Pivot,	Power	Query	and	Power	BI 3	-	5	Nov	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 3	Days

Online	(Australia) Excel	Tips	and	Tricks 10	Nov	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 1	Day

Online	(Australia) Financial	Modelling 11	-	12	Nov	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 2	Days

Online	(Australia) Power	Pivot,	Power	Query	and	Power	BI 8	-	10	Dec	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 3	Days

Online	(Australia) Excel	Tips	and	Tricks 15	Dec	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 1	Day

Online	(Australia) Financial	Modelling 16	-	17	Dec	2021 09:00-17:00	AEDT (-1	day)	22:00-07:00	GMT 2	Days


